
RELEASE NOTES

Release Notes for Modo15.2v1

Release Date
09 November 2021

System Requirements

Officially Supported Operating Systems
• macOS 10.14.x, 10.15.x, and 11.x

Note: Testing on Apple Silicon (M1) processors, macOS 12 (Monterey), and Windows 11 is in
progress and this statement will be updated when completed.

• Windows 10 (64-bit only)

• Linux 64-bit operating system (CentOS/RHEL 7.6+)

Minimum Hardware Requirements
• Intel processor(s), Core i3 or higher

• 10 GB available hard disk space (for a full Modo and content installation)

• At least 2 GB RAM

• Display with 1920 x 1080 pixel resolution

• Internet connection for product activation and online videos access

• The Advanced viewport mode requires an NVIDIA or AMD graphics card with at least 1 GB of GPU
memory and drivers that support OpenGL 4.4 or higher.

• AMD AI Denoiser requires a minimum of 4 GB of GPU memory.
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Recommended System Requirements

Note: This information is our best recommendation for the average user. Requirements
vary by usage, and individual users may have different requirements from those listed here.

• 2.5+ GHz quad-core processor

• 250+ GB disk space available for caching and temporary files, SSD is preferable

• 16 GB RAM with additional virtual memory*

• Display with 1920 x 1080 pixel resolution

• An NVIDIA or AMD graphics card with the latest drivers

• 2+ GB of graphics memory

• OpenGL 4.4 or higher support

*The use of virtual memory improves stability and helps prevent data loss on large projects.

Recommended Graphics Driver Versions
• NVIDIA: 461.09 or later

• AMD: 8.982.8.1 or later

Note: We recommend downloading the latest driver version from the NVIDIA or AMD
websites

Tested Workstation Hardware

The configurations listed below are those that Foundry have tested with Modo 15.2. Due to the
constantly changing nature and wide variety of computer hardware available in the market, Foundry
is unable to officially certify hardware. The list below can be used as a recommendation and does not
guarantee that it meets your particular needs.

Note: Hardware marked with * (asterisk) was unavailable for QA testing for Modo 15.2
because of office access limitations due to COVID-19, but has been used to test previous
releases.

Release Notes for Modo15.2v1 |
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If you encounter any issues, please visit the Support Portal at https://support.foundry.com.

Tested Workstation Hardware

Apple • Macbook Pro (Retina, 16-inch, 2019)

• Macbook Pro (Retina, 15-inch, 2018)

• Macbook Pro (Retina, 15-inch, 2017)

CPU • AMD Ryzen Threadripper*

• Intel i7-7700k*

• Intel i7-8700

• Intel i9-9900k

• Intel Core i7 10750H

Tested GPU Hardware

AMD Prosumer Graphics Cards • Radeon Vega RX*

AMD Enterprise Graphics Cards • Radeon Pro 5300M

• Radeon Pro WX 8200

• Radeon Pro WX 7100

• Radeon Pro 560X

• Radeon Pro W6600

NVIDIA Prosumer Graphics Cards • GeForce GTX 1070 Ti (Linux)

• GeForce 1080*

• GeForce 2070 Super

NVIDIA Enterprise Graphics Cards • Quadro T1000

• Quadro M4000*

Release Notes for Modo15.2v1 |
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New Features

Assembly Preset Workflow

Modo’s Preset system and Assemblies have long been a valuable workflow component. The new
Assembly Preset Workflow refines this further by simplifying the creation process and making presets
easier to share. Presets are now packaged, containing associated content like images within a Preset
Package. When you pass a preset to another artist, you can now be sure they have the supporting
content that they need.

The new Preset system automatically creates an assembly in your scene, more closely linking the
relationship between presets and assemblies. Assemblies no longer need to have every element
exposed in a schematic assembly. The Stack Nodes and Schematic now contain the elements needed
to do more of your work without leaving Schematic.

See Easily Share Presets with Assembly Presets for more information.

Primitive Slice

Curves are an essential component of modeling today. Primitive slice further elevates Modo’s curve
modeling capabilities by allowing users to slice primitive shapes into geometry and even produce
boolean effects with depth control when leveraging the procedural variant of the tool with the slice
effector.

See Creating Geometry on a Mesh Using Preset Shapes for more information.

Edge Subdivide Command

Simple features can have a big impact on workflow. Edge Subdivide simply divides each selected edge
into multiple edges, making it easier to add vertices along an edge. This is tremendously useful for
quickly modifying and refining topology.

See Adding Additional Vertices to an Edge for more information.

MeshFusion Workflow Refinement

In 15.0, Mesh Fusion workflow was completely reenvisioned. With 15.2 we’ve taken this further by
removing Fusion Selection Modes. Now you simply select the element you want to modify and we
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give you the info you need.

See MeshFusionfor more information.

Geodesic Distance Modifier

Procedurally generating 2D designs on 3D surfaces is extremely valuable for designers. The geodesic
distance modifier can be leveraged to find the distance between two points and trace a path between
them on the surface. This enables generation of complex patterns that can drive exciting, procedural
modeling results.

See Geodesic Modifier for more information.

Set Vertex Normals + Largest Normals

Control over vertex normals and vertex maps in general is a very important part of 3D in general and
specifically for real time renderers. The largest normals option is now a part of material smoothing
properties. The color tool and Set RGB node now have an option for Discontinuous values,
eliminating color blending across the boundary of a selection. Finally, a Set Vertex Normals MeshOp
has been added, further expanding what’s possible in our procedural toolset.

See Using The Set Vertex Normals MeshOp to Adjust the Appearance of Your Mesh for more
information.

SelectionOp Stack Node

Modo’s Order Of Operations system is extremely powerful. However, it can be difficult to understand
the order of MeshOps and SelectionOps in the schematic viewport. The MeshOp Stack node was
added in 15.1. In 15.2 we have added this ability for Selection Ops, better informing artists of how a
stack relates to a node graph.

See Organization within the Schematic Viewport using the Selection Stack for more information.

mPath Render Booleans

mPath is Foundry’s powerful new hybrid pathtrace renderer. In 15.2 we’ve added Render booleans.
This makes it incredibly easy to create cross section cutaways for product and graphical
visualizations.

See Rendering Booleans with mPath for more information.
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TuneUps

With every release, we try to touch on existing features and workflows with meaningful refinements.
The Script Editor has received many improvements to make scripting a more comfortable experience.
Convert Instances to Replicas makes it easier to switch between instancing and replicators. Playblast
waits for Advanced progressive let’s artists take advantage of progressive antialiasing when creating
viewport playblasts. And the PBR loader will now automatically add imported PBR textures into
groups that already have the correct polygon tags.

Feature Enhancements

File I/O
• ID 446539 - Importing or exporting an .obj file now replaces spaces in the file name with
underscores.

• ID 487461 - PBR Loader now includes an option to match existing material groups.

MeshFusion
• ID 486856 - Fusion Strip attributes now support OmniHaul.

Modeling
• ID 380301 - An option to forcibly set discontinuous values has been added to the Vertex Color tool.

• ID 469082 - Unsubdivide performance has been improved.

• ID 482192 - The Mirror tool now sets Invert Polygons by default.

• ID 485609 - Weight Map Transfer performance has been improved.

• ID 488500 - Boolean performance with co-planar faces has been improved.

• ID 490991 - Edges to Curves now generates more stable indices for the curves.

Presets
• ID 471177 - You can now drag presets to the parent folder in the Preset browser.

Release Notes for Modo15.2v1 | Feature Enhancements
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Procedurals
• ID 424839 - Set Vertex Map now includes a Largest option for material weighting and Largest
Normals option.

• ID 477305 - The Set RGB mesh operation now supports discontinuous values.

Rendering
• ID 454434 - mPath now supports render Booleans.

Rigging
• ID 480320 - The way Command Regions / Rig Clay were using reference transforms has been
rewritten to improve stability and flipping of the rigs.

Bug Fixes

Animation
• ID 485940 - Launching Modo with no channel list in the Graph Editor caused the application to
crash.

• ID 486113 - Changing subdivision level during animation playback caused Modo to crash.

Deformers
• ID 481662 - Editing certain meshes driven by deformers caused Modo to crash.

• ID 486874 - Enabling Deferred Evaluation > Smoothing occasionally caused Modo to crash.

File I/O
• ID 484300 - macOS only: Opening a scene from Finder containing missing images caused Modo to
crash.

• ID 485867 - FBX meshes incorrectly exported Actors and Actions.

• ID 486073 - Undoing a mesh drag and drop to another scene occasionally caused Modo to crash.

• ID 487446 - The Normal option was missing from the PBR Loader preferences.

• ID 487984 - Animated .usd files did not export the skin correctly unless exported in setup mode.

• ID 490841 - Camera attributes were scaled incorrectly when exporting to the .usd format.

Release Notes for Modo15.2v1 | Bug Fixes
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• ID 492782 - Animated .fbx files did not export the skin correctly unless exported in setup mode.

MeshFusion
• ID 485879 - MeshFusion occasionally crashed with preview running.

• ID 485953 - MeshFusion was slower than expected with Deferred Updates enabled.

• ID 486906 - MeshFusion channels were not displayed in the same order in the Properties and
channel haul windows.

Modeling
• ID 461646 - The Set Weight tool did not include tooltips.

• ID 463342 - Booleans were not creating a solmesh in some instances.

• ID 467026 - Edge Chamfer created undesirable UVs in some instances.

• ID 472943 - Undoing Linear Falloff occasionally caused Modo to crash.

• ID 478423 - Edge Chamfer produced uneven edges across edge loops.

• ID 479330 - Edge Chamfer occasionally produced invalpositions when moving geometry to the
origin.

• ID 480154 - Edge Chamfer occasionally stopped working when Shape was set to Square.

• ID 480646 - Edge Chamfer occasionally produced asymmetrical results.

• ID 480942 - Edge Chamfer was performing slower than expected.

• ID 481419 - Boolean > Union All failed with some co-planar polygons.

• ID 482246 - Dimensions set to Orient To Selection would fail on triangulated meshes.

• ID 482301 - Edge Chamfer gave undesirable results when Offset in Parallel was enabled, and
multiple loops were selected.

• ID 482909 - Edge Chamfer mitering removed polygons unexpectedly.

• ID 483112 - Using push on symmetrical geometry occasionally pushed in the opposite direction.

• ID 483264 - Windows only: Curve Booleans occasionally caused Modo to become unresponsive.

• ID 483802 - Edge Chamfer concave patches occasionally produced undesirable results.

• ID 484592 - Element Move did not respect the rig option when components were selected.

• ID 484789 - Edge Chamfer created the wrong end shape if a co-planar edge was connected.

• ID 485019 - Edge Chamfer creating incorrect rounding on some corners.

• ID 485597 - Editing edge weights on irregular topology occasionally caused Modo to crash.

• ID 485615 - Sync Index Order did not automatically attempt to match islands on the same mesh with
the same topology.

• ID 485685 - Polygon Bevel Square Corner did not work as expected on scaled meshes.

• ID 485771 - Large chamfers occasionally caused polygons to disappear.

Release Notes for Modo15.2v1 | Bug Fixes
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• ID 485939 - Using the direct modelling merge meshes command on a transformed procedural mesh
caused Modo to crash.

• ID 486785 - Canceling options in the Static Analysis viewport displayed an error.

• ID 487013 - Loop Slice on a high number of segments occasionally caused Modo to crash.

• ID 487567 - Static Analysis Unused Deformers listed tool pipes incorrectly.

• ID 487961 - Deleting segments of a bezier curve occasionally caused Modo to crash.

Presets
• ID 468216 - Exporting a mesh from the Item List after creating or selecting its material item created
an empty .lxp file.

• ID 468221 - Canceling Replace Icon with Image File on a preset displayed an error message.

• ID 471169 - Comments on presets were displayed against the incorrect preset.

• ID 483650 - Clicking Replace Icon with Image File for presets opened the scene unexpectedly.

• ID 485937 - Adding certain presets occasionally caused Modo to crash.

Preview
• ID 483711 - Changing layout after locking a preview could cause the UI to become unresponsive.

• ID 490760 - macOS only: Preview did not update when changing material properties.

• ID 492107 - Moving the camera when preview was locked caused Modo to crash.

Procedurals
• ID 226508 - Weights were not always updated as expected on procedural meshes.

• ID 456434 - Scene Cleanup > Unused Deformers did not remove unused mesh operations.

• ID 480105 - The Vertex Bevel meshop did not support negative inset as expected.

• ID 485227 - Edges to Curves occasionally flipped the curve when re-evaluated.

• ID 485932 - Using bezier curves in Curve Offset By Mesh caused Modo to crash.

• ID 486081 - Using Procedural Loop Slice on a curve caused Modo to crash.

• ID 486859 - Fixing a procedural using the Static Analysis floating vertices / one point polygons test
caused Modo to crash.

Rendering
• ID 412084 - Foreground image masks resulted in aliased edges.

• ID 473682 - mPath: Shadow catchers produced a noisy alpha channel.

Release Notes for Modo15.2v1 | Bug Fixes
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• ID 481079 - mPath: Alpha was not considered for adaptive sampling when the beauty pass passed
the requirements.

• ID 482666 - mPath: Antialias settings were not respected for render outputs.

Rigging
• ID 295273 - Schematic nodes could not be connected if they contained more than 256 channels.

• ID 448914 - The IK solver occasionally flipped when going in and out of setup mode.

Note: Any rigs hitting this issue need to recreate the solver for the fix to take effect.

• ID 484119 - Command Regions occasionally did not draw as expected.

• ID 487304 - MeshOp Stack nodes occasionally caused ghosted views on other layers to display
incorrectly.

Schematic
• ID 471077 - Dragging an assembly into the schematic overview did not creates a new workspace as
expected.

• ID 481318 - Lasso select in the Schematic viewport incorrectly selected nodes inside closed
Backdrop nodes.

• ID 484221 - Dragging an item to the Schematic viewport failed when an assembly was selected.

• ID 484362 - Items in sub-assemblies were not hidden when converting to an alias.

Scripting
• ID 478911 - Pressing Shift+Enter in the Script Editor displayed an error.

• ID 480108 - The alt gr modified keyboard shortcut did not work as expected in the Script Editor.

• ID 481626 - Certain non-unicode characters in item names caused failures running Python scripts.

SDK/TD-SDK
• ID 483649 - TD SDK: Removing items in a loop occasionally caused Modo to crash.

• ID 485949 - Python lxifc.LogListener stopped Modo shutting down correctly.

Shader Tree
• ID 473444 - Normal Maps propogated farther up the shader tree than expected.

Release Notes for Modo15.2v1 | Bug Fixes
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• ID 483997 - Creating an Image Layer, such as Gradient Fill, did not place the layer correctly in the
shader tree.

• ID 486005 - Scenes containing an Iridescence shader caused Modo to crash on exit.

UI
• ID 366868 - The Cylinder tool's controls contained incorrect tooltips.

• ID 399079 - Mini gradients did not size correctly.

• ID 463770 - Undoing a mini-slider change with Allow Modifier Chording enabled caused Modo to
crash.

• ID 477408 - Right-click context menus occasionally showed incorrect options.

• ID 479155 - The Alt+Space pie menus Topology option did not work as expected.

• ID 479786 - The State column in the Graph Editor was missing.

• ID 481008 - The cursor occasionally got stuck on the pan icon.

• ID 482407 - Form Command filters were incorrect when using the != operator.

• ID 482493 - The Channel Sets window had misaligned icons.

• ID 482616 - Incorrect characters were displayed in the Split and Sew tooltip.

• ID 486028 - Right-clicking in a different viewport after Lasso selecting occasionally displayed an
error.

• ID 487026 - The Form Editor saved the form proficiency incorrectly.

• ID 487165 - Choosing Group By Package in the Channels viewport caused Modo to crash.

• ID 487447 - A divider set to proficiency Advanced in the form editor set multiple sub-sheets to Last
Instance.

UVing
• ID 404381 - UV Split occasionally failed to split all selected edges.

• ID 460304 - Zero area triangles occasionally caused Pack UVs to fail.

• ID 462362 - Activating Channel Haul with multiple items selected occasionally caused Modo to crash.

• ID 474904 - Pack UVs did not align correctly when using vertical or horizontalmodes.

• ID 483121 - Element move snapped incorrectly in the UV viewport.

Known Issues
This section covers some known issues and gives workarounds for them, where appropriate.

Release Notes for Modo15.2v1 | Known Issues
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Animation
• ID 423909 - Grease Pencil - Setting image type to JPG results in a black fill over the screen.

• ID 395357 - Deformer Caching doesn’t work.

• ID 240321 (53661) - Selecting actions does not always select the correct one. This is caused by
copying actions.

Note: As a workaround, manually edit the tags on the broken actions by selecting them in
the Groups tab, then save and reload the scene.

Assemblies
• ID 288164 (36452) - Assemblies exported from the Item List context menu result in poor visual
layout of nodes on import.

Note: As a workaround, you can save assemblies from the Schematic viewport.

Baking
• ID 293020 (50671) - Baking displacement maps can cause UV seams to be visible, and the baked
displacement map to show quilting effects and other render artifacts.

• ID 221481 (49437) - The Bake Channel Swizzling option can’t bake to texture alpha.

Bucket Render
• ID 279848 (55663) - Motion Blur applied on a curve in a Mesh Operation no longer works.

• ID 235368 (53411) - Mesh lights or any direct light too close to a surface can produce fireflies (hot
pixels) in some cases.

Note: As a workaround, use a Maximum Radiance higher than 1 W/srm2 to reduce the bias.

• ID 243070 (53793) - Rendering using a Dual CPU with 72 threads was significantly slower than
expected.

Release Notes for Modo15.2v1 | Known Issues
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Note: As a workaround, any machine that has more than 32 cores, performance will be
better if you limit rendering to half the number of cores you have.

• ID 292947 (53184) - Value presets created for material Subsurface Scattering samples in Modo 10.1
or earlier now show on the render item instead.

• ID 297021 (52730) - The Vertex Illumination Bake command doesn't work as expected, when the
mesh has transform channels.

Note: As a workaround, freeze the transforms in the mesh properties.

Color Management
• ID 221439 (49244) - Windows only: With Perform Color Correction on, setting a default scene to a
scene with a mesh that has a position channel crashes Modo at launch.

Note: As a workaround, use System > Reset Preferences to reset to defaults or
move/remove the default scene.

Command Line
• ID 289290 (49514) - macOS only: Running modo_cl before running the UI Modo application breaks
code signing.

Note: As a workaround, start the UI version of Modo once, before running modo_cl on any
system where you later intend to use the UI version.

File and Image I/O
• ID 346842 - Alembic import - Drag/drop doesn't import animation correctly.

Note: As a workaround, use File > Import.

Release Notes for Modo15.2v1 | Known Issues
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• ID 337523 (56862) - Modo for SolidWorks Kit: Modo crashes when importing the same SolidWorks
file twice in one Modo session. This only affects import using the kit, not direct imports (File >
Import).

Note: As a workaround, before importing a SolidWorks file for the second time, exit and
restart Modo.

• ID 221508 (50198) - Alembic scenes don't export some surface items, including static meshes and
procedural shatter items.

• ID 226589 (49728) - Exporting selected layers (from the Item List context menu) to .fbx doesn't
export instances, unless the original mesh is also exported.

Note: To resolve this, set the .fbx preference to Export Selection and use the Export As…
option.

• ID 220991 (47036) - Color management in .svg images is not currently supported. This is a side-effect
of a fix where the largest allowable image size (64k x 64k) was always used when color correction
was enabled.

• ID 220975 (46962) - Rendering .svg images used as stencil maps for displacement or for layer
masking can be very slow.

Fur
• ID 288248 (35731) - Fur length textures can’t be edited with the Stretch tool.

Note: Use different fur length drivers, such as hair guides or vector vertex maps.

Input Devices
• ID 303287 (35856) - Linux only: Plugging in a Wacom tablet while Modo is running can cause
undesired movement. This cannot be fixed, due to a limitation of the hardware driver.

Note: To avoid this, plug in the tablet before application start up or restart.

• ID 226536 (51741) - macOS only: Modo sometimes becomes unresponsive when using the
combination of a click-drag in a tree view (for example, when toggling the visibility of two successive

Release Notes for Modo15.2v1 | Known Issues
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items in the Shader Tree), followed immediately by a two-finger scroll gesture on some devices,
including laptop trackpads and the Magic Mouse.

Note: As a workaround, change to a 3-button mouse (recommended to fully access all of
Modo's features).

MeshFusion
• ID 316276 (56973) - If a Trim Fusion role is assigned to an object and then it is dragged and dropped
onto a Primary, the drop menu does not contain the Trim Boolean options.

Note: As a workaround, use either the Fusion Buttons (Tool palette - Set Mesh Role &
Apply section) or Pie Menu (Apply SubtractionApply Intersection or ) when initially adding
Trims to each Fusion Item (Trims can contribute to multiple Fusion Items). If initially applied
with either of those methods, all subsequent Drag & Drop options will be supported.

Modeling
• ID 408278 (60027) - Linear Falloff snaps to object size.

Note: As a workaround, use the right mouse button for an interactive initial linear handle.

• ID 226970 (32728) - Zooming out with a Space Navigator alters the Work Plane position.

Network Rendering
• ID 226363 (48325) - Scenes with image sequences rendered with Full Frames use the wrong image
sequence number on slave machines.

Note: As a workaround, use File > Consolidate Scene, then render the scene using a
shared network folder (Preferences option under Rendering > Network Rendering).

• ID 226337 (36986) - Slaves render hidden meshes. Since mesh hide state is not stored in the scene,
when that scene is transferred to the slaves, the state is lost. The master respects the hidden state,
however.

Release Notes for Modo15.2v1 | Known Issues
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Note: As a workaround, if the intent is to avoid rendering, toggle the visibility for the item
or render or open System > Preferences > Rendering and disable Use Network Render
Nodes.

• ID 226336 (25636) - Frame passes are not supported.

• ID 220955 (30318) - Network Rendering doesn’t support Realflow particles.

• Several bugs - While it apparently worked in Modo 902, in some cases, Network Rendering was not
implemented to support baking. Changes to Modo in the 10-series apparently broke what was
working for some artists, so the functionality has been disabled.

Note: As a workaround, Modo 10 implemented the ability to Network Bake using Bake
Items and an external render controller. For more information, please see the SDK Wiki.

Nodal Shading
• ID 385250 - Nodal Shading is slower in 13.0 with some modifiers.

• ID 221393 (50642) - Nodal shading does not support UDIMs.

Painting/Sculpting
• ID 288461 (41682) - Textures are not always updating in Preview/Render when painting on an image
map.

Note: You can save and reload the image to force the update.

Particles
• ID 303192 (34925) - Re-opening scenes saved with large particle caches can cause problems.

Note: To avosuch issues, delete the cache before closing Modo, or export the particles to
.csv cache files or Realflow .bin files. You can do this by attaching one of those nodes to the
Particle Simulation item in the Schematic viewport, and clicking Cache Simulation.

Release Notes for Modo15.2v1 | Known Issues
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Preview Render

• If a high poly mesh is not visible, the Preview baking output will be incorrect.

Note: As a workaround, reset Preview to fix the baking.

Presets
• ID 242621 - Assembly Preset Aliases will crash when certain connections are made to them. If any of
these are inside of an assembly alias that is collapsed, then you can potentially hit a crash:
Replicator Item, Array Operator modifier, Falloff Operator, Selection Operator, Particle Operator,
Any kind of texture (images, procedural textures, etc)

Note: As a workaround, expand the assembly alias, as evaluating those types of items for a
non-aliased assembly should still work fine.

Procedurals
• ID 484639 - Select by Material Tag doesn't work with Mesh Op stack.

• ID 388978 - Paving does not work when a Guide curve runs through a paving hole

• ID 305303 (56318) - Procedural duplication of Mesh Ops in a Deform folder creates errant Mesh Ops
list.

• ID 305302 (56317) - Duplication of Procedurals does not work with the Select By Previous Operation
tool.

Note: As a workaround, manually edit the duplicate's Select By Previous Operation Mesh
Ops.

• ID 266469 (54738) - A duplication of any item that is a Merge Meshes Source (For example, a Mesh
Item, Procedural Item, or Fusion Item), any duplicates (duplicate or instance) are added to the Merge
Meshes Ops List as a source.

Release Notes for Modo15.2v1 | Known Issues
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Note: As a workaround, remove the unwanted additional Merge Mesh Sources (regardless
of the type of source) in the Mesh Ops List using the X icon in that list next to each Merge
Meshes source.

• ID 221355 (52149) - Curve Extrude mesh operation: The Path Segment Generator's Align to Normal
option doesn't work when using a Bezier with zero-length tangents.

Note: As a workaround, rotate the polygons to point toward the +Z before extruding or
make sure there are no zero-length tangents.

• ID 289810 (46512) - When rigged, Rock items and other procedurals do not display correctly in GL.
This is a limitation of the feature and will not be fixed.

Note: You can use Preview or RayGL to visualize the variations from rigging.

References
• ID 309252 (56620) - Modo crashes when closing a scene containing a referenced scene after
attempting to revert a reference override.

Note: As a workaround, first close and reopen the scene before attempting to revert the
reference.

• ID 294394 (44492) - If a scene that already contains references is referenced, the shading of the
original references may not persist.

Note: As a workaround, limit scenes with shading to one level of reference.

• ID 220957 (41119) - Reloading a reference after replacing it with the same file can cause Modo to
crash.

Rigging
• ID 483457 - Disabling or hiding connections using the H keyboard shortcut causes the stack order to
behave erratically.
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• ID 404238 - Bezier Curves don’t work correctly with the Curve Falloff.

• ID 287584 (27244) - Duplicating joints in a bound mesh retains influences from the original joint
chain.

Scripting
• ID 242545 (53458) - Right-clicking or running a script in the Script Editor can lock up input to Modo.

Note: As a workaround, click in the top window of the Script Editor, use the main menus, or
change to another application, then switch back to Modo.

Shader Tree
• ID 385991 (57874) - Custom Materials that define their own smoothing properties (such as the Skin
material), no longer smooth the mesh correctly.

• ID 299187 (37858) - In the Shader Tree, choosing a group from Add Layer > Image Map > (use clip
browser) fails.

Note: To work around this issue, in the Clip Browser, choose a single image instead of the
group, and then change to the image group using the Texture Layer's Properties tab.

• ID 288141 (30947) - Layer masking displacement does not work unless you drag and drop the
masking layer onto the displacement layer.

Unreal and Unity Materials
• ID 295862 (50700) - There is no way to visualize the Unreal SubSurface Color effect in Modo.

• ID 294747 (50701) - Unreal material Ambient Occlusion does not bake correctly in Modo.

• ID 221477 (50451) - On some graphics cards, Unity material may cause flickering in the Advanced
viewport when used with bump maps and shadows.

UI
• ID 395884 - Mac only - Double-clicking bottom right corner or edge of popover doesn't resize back
the popover correctly.

• ID 388937 - macOS only: UI form field highlights can appear gray.

• ID 333249 (57715) - Selecting items in the viewport does not always update the Properties form.
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Note: As a workaround, click the alt key.

• ID 288714 (43162) (Windows only) -Setting a custom text size affects Modo's text drawing.

Note: As a workaround, go to the compatibility settings by right-clicking the Modo shortcut
or executable, and turn off font-scaling for the application.

• ID 281374 (55759) - Transforming objects can cause the Items Properties panel to flicker.

• ID 277244 (55571) - Resizing the dopesheet in Zen crashes Modo 11.1, but not in Modo 11.0.

• ID 273139 (55185) - Text in the viewport icon buttons is not visible in the Advanced viewport on some
macOS/AMD configurations.

Note: As a workaround, upgrade Mac OS to 10.13.

• ID 226492 (44496) - macOS only: Disabling Affect System Color Dialog in Preferences > Rendering >
Color Management, and using the system color picker caused colors to darken with each use of the
color picker.

Note: This is due to an OS X issue, which requires the color profile in both the monitor
settings and color picker to be set to sRGB IEC61966-2.1.

• ID 224169 (44896) - Dragging and dropping an image from disk into the Clips list doesn’t work.

Note: If the Clips list is empty, drop the image onto the bar at the top, otherwise drop it
above or below other images in the list.

Viewports

• ID 478549 - Saving Alpha with Playblast is just completely white.

• ID 420733 - Ghost Mode Transparency set to 0% isn't fully transparent.

• ID 408416 - Gradient (texture layer) renders incorrectly in the Advanced Viewport.

Note: As a workaround, use Preview.
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• ID 310930 (56706) - Unity and Unreal materials are not displayed correctly when first loaded into the
Advanced viewport.

Note: As a workaround, enable and then disable the visibility of the Shader Tree textures.

• ID 281365 (55816) - Wireframes are washed out on transparent surfaces in the Advanced viewport.

Note: As a workaround, avoid transparency when modeling or doing work where
wireframes are needed. Alternatively, use the Default viewport.

• ID 338374 (58003) - Game Navigation mode (camera rotation) does not work in a floating 3D view
(palette or separate window).

Note: As a workaround, use Game Navigation mode only in docked 3D views (views that are
part of a Layout).

• ID 338599 (57955) - Clicking on the VR layout tab may crash when using a system with a Radeon WX-
series graphics card. This is due to a driver and should be fixed by a AMD in a future driver release.

• ID 289738 (49473) - Projections are incorrect if the projecting camera is set to Vertical film fit mode
and the width is less than the height.

• ID 289020 (43771) - Camera projections from non-render cameras show distortion in GL and baking.

Note: To avoid this, make sure that the projection camera has a film width-to-height ratio
that matches the main render camera.

• RGBA textures only draw correctly in the Advanced viewport. In the Default viewport, any
unsupported texture effect on an image map is drawn as diffuse color when the layer is selected in
the Shader Tree.

• Windows only: Using Raptr can cause GL driver crashes in Modo.

VR
• ID 218386 - VR is now supported on Linux, but has only been tested and verified working using
SteamVR on Ubuntu 18.04.
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